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Preface

This manual describes Campus Manager 3.3 and provides instructions for 
installing and configuring it.

Audience
This document is for anyone who installs, configures, verifies, and uses Campus 
Manager (Campus) software. Network administrators or operators should have 
the following skills:

• Basic Solaris system administrator skills

• Basic network management skills

• Basic Internet browser skill

Conventions
This document uses the following conventions:

Item Convention

Commands and keywords boldface font

Variables for which you supply values italic font

Displayed session and system information screen font
vii
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Preface
Conventions
Note Means reader take note. Notes contain helpful suggestions or references to 
material not covered in the publication. 

Caution Means reader be careful. In this situation, you might do something that could 
result in equipment damage or loss of data.

Information you enter boldface screen font

Variables you enter italic screen font

Menu items and button names boldface font

Selecting a menu item in paragraphs Option> Network Preferences

Selecting a menu item in tables Option > Network Preferences

Item Convention
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Product Documentation
Product Documentation

Note Although every effort has been made to validate the accuracy of the information 
in the printed and electronic documentation, you should also review the Campus 
Manager 3.3 documentation on Cisco.com for any updates.

The following product documentation is available: 

• Release Notes for Campus Manager 3.3 on Windows 

• User Guide for Campus Manager

• Context-sensitive online help

Release Notes for Campus Manager 3.3 on Windows 

This document describes the known problems for the Campus Manager 3.3 
software on Windows. This document is available in the following formats:

• On Cisco.com at 
http://www.cisco.com/univercd/cc/td/doc/product/rtrmgmt/cw2000/
camp_mgr/camp_3x/cmgr_3_3/rel_note/index.htm

• Printed document available bundled with the product.

User Guide for Campus Manager 

This document describes the use and operation of Campus Manager, including 
application descriptions, scenarios, and troubleshooting. This document is 
available in the following formats: 

• PDF on the Campus Manager 3.3 CD-ROM and from the Campus Manager 
3.3 online help.

• On Cisco.com at 
http://www.cisco.com/univercd/cc/td/doc/product/rtrmgmt/cw2000/
camp_mgr/camp_3x/cmgr_3_3/u_guide/index.htm

• Printed document available by order.
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Related Documentation
Context-Sensitive Online Help

You can access the help in two ways:

• Select an option from the navigation tree, then click Help.

• Click the Help button in the dialog box.

Supported Devices Table for Campus Manager 3.3

This document contains information on the devices supported for the Campus 
Manager 3.3 release and device support added with the Incremental Device 
Update (IDU). This document is available on Cisco.com at:

http://www.cisco.com/univercd/cc/td/doc/product/rtrmgmt/cw2000/camp_mgr/
sup_dev/cm_3_3.htm

Related Documentation

Note Although every effort has been made to validate the accuracy of the information 
in printed and electronic documentation, you should also review Cisco product 
documentation on Cisco.com for any updates.

The following additional documentation is available:

User Guide for CiscoWorks Common Services

This document describes the use and operation of CiscoWorks Common Services, 
including application descriptions, scenarios, and troubleshooting. This 
document is available in the following formats: 

• PDF on the CiscoWorks Common Services 2.2 CD-ROM and from the 
CiscoWorks Common Services 2.2 online help.

• On Cisco.com 
http://www.cisco.com/univercd/cc/td/doc/product/rtrmgmt/cw2000/
camp_mgr/camp_3x/cmgr_3_3/u_guide/index.htm

Printed document available by order.
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Additional Information Online
Installation and Setup Guide for CiscoWorks Common Services on Windows

This document describes instructions for installing and configuring the 
CiscoWorks Common Services Application on Windows. This document is 
available in the following formats: 

• PDF on the CiscoWorks Common Services 2.2 CD-ROM 

• On Cisco.com at 
http://www.cisco.com/univercd/cc/td/doc/product/rtrmgmt/cw2000/
cw2000_d/comser22/ig_wincv/index.htm

• Printed document available by order.

Release Notes for CiscoWorks Common Services 2.2 on Windows

This document describes the known problems for the CiscoWorks Common 
Services software on Windows. This document is available in the following 
formats:

• On Cisco.com at 
http://www.cisco.com/univercd/cc/td/doc/product/rtrmgmt/cw2000/
cw2000_d/comser22/rel_note/index.htm

• Printed document available bundled with the product.

Additional Information Online
Incremental Device Update (IDU) contains updated files necessary for the latest 
device support and fixes to known problems that are not available in Campus 
Manager 3.3. If you are a registered user, you can download IDU for Campus 
Manager from:

http://www.cisco.com/cgi-bin/tablebuild.pl/cw2000-campus

Obtaining Documentation
Cisco provides several ways to obtain documentation, technical assistance, and 
other technical resources. These sections explain how to obtain technical 
information from Cisco Systems.
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Obtaining Documentation
Cisco.com
You can access the most current Cisco documentation on the World Wide Web at 
this URL:

http://www.cisco.com/univercd/home/home.htm

You can access the Cisco website at this URL:

http://www.cisco.com

International Cisco web sites can be accessed from this URL:

http://www.cisco.com/public/countries_languages.shtml

Documentation CD-ROM
Cisco documentation and additional literature are available in a Cisco 
Documentation CD-ROM package, which may have shipped with your product. 
The Documentation CD-ROM is updated monthly and may be more current than 
printed documentation. The CD-ROM package is available as a single unit or 
through an annual subscription.

Registered Cisco.com users can order the Documentation CD-ROM (product 
number DOC-CONDOCCD=) through the online Subscription Store:

http://www.cisco.com/go/subscription

Ordering Documentation
You can find instructions for ordering documentation at this URL:

http://www.cisco.com/univercd/cc/td/doc/es_inpck/pdi.htm

You can order Cisco documentation in these ways:

• Registered Cisco.com users (Cisco direct customers) can order Cisco product 
documentation from the Networking Products MarketPlace:

http://www.cisco.com/en/US/partner/ordering/index.shtml

• Registered Cisco.com users can order the Documentation CD-ROM 
(Customer Order Number DOC-CONDOCCD=) through the online 
Subscription Store:
xii
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Obtaining Technical Assistance
http://www.cisco.com/go/subscription

• Nonregistered Cisco.com users can order documentation through a local 
account representative by calling Cisco Systems Corporate Headquarters 
(California, U.S.A.) at 408 526-7208 or, elsewhere in North America, by 
calling 800 553-NETS (6387). 

Documentation Feedback
You can submit comments electronically on Cisco.com. On the Cisco 
Documentation home page, click Feedback at the top of the page.

You can email your comments to bug-doc@cisco.com.

You can submit your comments by mail by using the response card behind the 
front cover of your document or by writing to the following address:

Cisco Systems
Attn: Customer Document Ordering
170 West Tasman Drive
San Jose, CA 95134-9883

We appreciate your comments.

Obtaining Technical Assistance
Cisco provides Cisco.com, which includes the Cisco Technical Assistance Center 
(TAC) Website, as a starting point for all technical assistance. Customers and 
partners can obtain online documentation, troubleshooting tips, and sample 
configurations from the Cisco TAC website. Cisco.com registered users have 
complete access to the technical support resources on the Cisco TAC website, 
including TAC tools and utilities. 

Cisco.com
Cisco.com offers a suite of interactive, networked services that let you access 
Cisco information, networking solutions, services, programs, and resources at any 
time, from anywhere in the world. 
xiii
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Obtaining Technical Assistance
Cisco.com provides a broad range of features and services to help you with these 
tasks:

• Streamline business processes and improve productivity 

• Resolve technical issues with online support

• Download and test software packages

• Order Cisco learning materials and merchandise

• Register for online skill assessment, training, and certification programs

To obtain customized information and service, you can self-register on Cisco.com 
at this URL:

http://www.cisco.com

Technical Assistance Center
The Cisco TAC is available to all customers who need technical assistance with 
a Cisco product, technology, or solution. Two levels of support are available: the 
Cisco TAC website and the Cisco TAC Escalation Center. The avenue of support 
that you choose depends on the priority of the problem and the conditions stated 
in service contracts, when applicable.

We categorize Cisco TAC inquiries according to urgency:

• Priority level 4 (P4)—You need information or assistance concerning Cisco 
product capabilities, product installation, or basic product configuration.

• Priority level 3 (P3)—Your network performance is degraded. Network 
functionality is noticeably impaired, but most business operations continue.

• Priority level 2 (P2)—Your production network is severely degraded, 
affecting significant aspects of business operations. No workaround is 
available.

• Priority level 1 (P1)—Your production network is down, and a critical impact 
to business operations will occur if service is not restored quickly. No 
workaround is available.
xiv
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Obtaining Technical Assistance
Cisco TAC Website

You can use the Cisco TAC website to resolve P3 and P4 issues yourself, saving 
both cost and time. The site provides around-the-clock access to online tools, 
knowledge bases, and software. To access the Cisco TAC website, go to this URL:

http://www.cisco.com/tac

All customers, partners, and resellers who have a valid Cisco service contract have 
complete access to the technical support resources on the Cisco TAC website. 
Some services on the Cisco TAC website require a Cisco.com login ID and 
password. If you have a valid service contract but do not have a login ID or 
password, go to this URL to register:

http://tools.cisco.com/RPF/register/register.do

If you are a Cisco.com registered user, and you cannot resolve your technical 
issues by using the Cisco TAC website, you can open a case online at this URL:

http://www.cisco.com/en/US/support/index.html

If you have Internet access, we recommend that you open P3 and P4 cases through 
the Cisco TAC website so that you can describe the situation in your own words 
and attach any necessary files.

Cisco TAC Escalation Center

The Cisco TAC Escalation Center addresses priority level 1 or priority level 2 
issues. These classifications are assigned when severe network degradation 
significantly impacts business operations. When you contact the TAC Escalation 
Center with a P1 or P2 problem, a Cisco TAC engineer automatically opens a 
case.

To obtain a directory of toll-free Cisco TAC telephone numbers for your country, 
go to this URL:

http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml

Before calling, please check with your network operations center to determine the 
level of Cisco support services to which your company is entitled: for example, 
SMARTnet, SMARTnet Onsite, or Network Supported Accounts (NSA). When 
you call the center, please have available your service agreement number and your 
product serial number.
xv
Installation and Setup Guide for Campus Manager on Windows

78-15050-01

http://www.cisco.com/tac
http://tools.cisco.com/RPF/register/register.do
http://www.cisco.com/en/US/support/index.html
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml


 

Preface
Obtaining Additional Publications and Information
Obtaining Additional Publications and Information
Information about Cisco products, technologies, and network solutions is 
available from various online and printed sources.

• The Cisco Product Catalog describes the networking products offered by 
Cisco Systems as well as ordering and customer support services. Access the 
Cisco Product Catalog at this URL:

http://www.cisco.com/en/US/products/products_catalog_links_launch.html

• Cisco Press publishes a wide range of networking publications. Cisco 
suggests these titles for new and experienced users: Internetworking Terms 
and Acronyms Dictionary, Internetworking Technology Handbook, 
Internetworking Troubleshooting Guide, and the Internetworking Design 
Guide. For current Cisco Press titles and other information, go to Cisco Press 
online at this URL:

http://www.ciscopress.com

• Packet magazine is the Cisco monthly periodical that provides industry 
professionals with the latest information about the field of networking. You 
can access Packet magazine at this URL:

http://www.cisco.com/en/US/about/ac123/ac114/about_cisco_packet_maga
zine.html

• iQ Magazine is the Cisco monthly periodical that provides business leaders 
and decision makers with the latest information about the networking 
industry. You can access iQ Magazine at this URL:

http://business.cisco.com/prod/tree.taf%3fasset_id=44699&public_view=tru
e&kbns=1.html

• Internet Protocol Journal is a quarterly journal published by Cisco Systems 
for engineering professionals involved in the design, development, and 
operation of public and private internets and intranets. You can access the 
Internet Protocol Journal at this URL:

http://www.cisco.com/en/US/about/ac123/ac147/about_cisco_the_internet_
protocol_journal.html

• Training—Cisco offers world-class networking training, with current 
offerings in network training listed at this URL:

http://www.cisco.com/en/US/learning/le31/learning_recommended_training
_list.html
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C H A P T E R 1

Prerequisites

This chapter describes the factors that you should consider before installing 
Campus Manager (Campus) on a Windows system.

This chapter contains:

• Product Overview

• Campus Upgrade Paths

• Server Requirements

• Client Requirements

• Supported Devices
1-1
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Chapter 1      Prerequisites
Product Overview
Product Overview
Campus, a member of the CiscoWorks Family of Products, is a suite of web-based 
network management tools that enables administrators to obtain various types of 
graphical views of their network topology and end-user information. Campus 
Manager is based on a client/server architecture that connects multiple web-based 
clients to a server on the network. 

The CiscoWorks Server supplies tools and services to the Campus Manager 
applications, including the Asynchronous Networks Interface (ANI) Server. The 
ANI Server discovers information about network devices and saves it in the ANI 
database for Campus applications, to access. For more information, see User 
Guide for Campus Manager, User Guide for CiscoWorks Server, online help for 
the CiscoWorks Server and online help for the ANI Server.

The Campus Manager applications are:

• Path Analysis—View the actual path that packets take between end 
nodes/devices on your network.

• User Tracking—Locate and display data about users and hosts in your network.

• Topology Services—Discover, view, and monitor the physical and logical 
services on your network.

• VLAN Port Assignment—View port information, configure VLANs on a 
trunk, and move ports between VLANs on your network.

• Discrepancy Reports—Discover and view physical and logical discrepancies 
in your network.

Campus Upgrade Paths
You can upgrade to Campus Manager 3.3 both from Campus Manager 3.1 and 
Campus Manager 3.2. Campus requires CiscoWorks Common Services 2.2, which 
is the foundation for the CiscoWorks family of products. 

When you install CiscoWorks Common Services 2.2, the previous version of 
Campus Manager is removed and only its database is preserved. When you install 
Campus Manager 3.3, certain data from the preserved database is converted to 
Campus Manager 3.3 format. 
1-2
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Chapter 1      Prerequisites
Server Requirements
This data includes:

• SNMP community strings

• User Tracking manually entered fields

• Seed devices

• User Tracking Preferences

• Path Analysis Preferences

• Topology views including Layer 2 View, Unconnected Device View and LAN 
Edge View

You must upgrade to CiscoWorks Common Services 2.2 before installing or 
upgrading to Campus Manager 3.3

Caution Uninstalling Campus deletes the ANI database.

Server Requirements
This section describes the system requirements and recommendations for 
CiscoWorks Common Services 2.2 and Campus Manager 3.3.

The minimum system requirements for CiscoWorks Common Services 2.2 and 
Campus Manager 3.3 are shown in Table 1-1.

Table 1-1 Server System Requirements Summary

Requirement Type Minimum Requirement1

System hardware • IBM PC-compatible computer with 500 MHz Intel 
Pentium processor

• CD-ROM drive

Memory (RAM) 512 MB 
1-3
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Server Requirements
Available drive space2 • 4 GB 

• Virtual memory equal to double the amount of memory 
(RAM). For example, if your system has 512 MB of 
RAM, you need 1024 MB of virtual memory.

• NTFS file system required for secure operation.

• At least 16 MB in Windows temporary directory 
(%TEMP%).

System software • ODBC Driver Manager 3.5.10

• Windows 2000 Professional or Server with Service Pack 
3 or higher

• Windows Advanced Server without enabling terminal 
Services.

Campus Manager supports only the US-English and Japanese 
versions of the Windows Operating System. It does not 
support any other language version.Set the default locale to 
US-English for US-English version and Japanese for 
Japanese version. 

Additional software

(Optional)

One of these browsers:

• Microsoft Internet Explorer 6.0 (version 6.0.2600.0000), 
and Internet Explorer 6.0 with Service Pack 1 (version 
6.0.2800.1106), Java Virtual Machine (JVM)5.0.0.3802 
and above, and Java plug-in version 1.3.1.To verify the 
JVM, select View > Java Console from Internet Explorer.

• Netscape Navigator 4.78 and 4.79.

CiscoWorks Common Services 2.2 must be installed before 
installing Campus. If you installed a version of CiscoWorks 
Common Services earlier than 2.2, upgrade to 2.2 before 
installing Campus Manager 3.3. See Installation and Setup 
Guide for CiscoWorks Common Services 2.2 on Windows.

1. If other applications are installed, or the number of devices on your network exceeds 500, the requirements might be greater.

2. Do not install CiscoWorks on a FAT file system.

Table 1-1 Server System Requirements Summary (continued)

Requirement Type Minimum Requirement1
1-4
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Client Requirements
Maximum Recommended Load
The maximum recommended load on servers configured with the minimum server 
requirements shown in Table 1-1 is 500 Cisco devices and one client at a time.

If other network management applications are installed on your server, additional 
resources might be required.

Server Recommendations
If your network has more than 500 Cisco devices, the following minimum 
requirements are recommended:

• 500 MHz Multiprocessor

• 512 MB of memory (RAM)

• 1 GB of virtual memory

• 4 GB drive space

Client Requirements
The minimum client system requirements for CiscoWorks Common Services 2.2 
and Campus Manager 3.3 are shown in Table 1-2. The maximum recommended 
load on clients configured with the minimum requirements shown is 1000 Cisco 
devices.

Note Before you can access Campus from a client system, you must configure the 
system properly. For information about configuring clients, see Installation and 
Setup Guide for CiscoWorks Common Services on Windows .
1-5
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Supported Devices
Supported Devices
For information about supported devices, access the Supported Devices table at 
the following location: 
http://www.cisco.com/univercd/cc/td/doc/product/rtrmgmt/cw2000/camp_mgr/
sup_dev/cm_3_3.htm

Table 1-2 Client System Requirements Summary

 Requirement Type Minimum Requirement

System Software and 
Hardware

• Client system:

– IBM PC-compatible computer with 300 MHz Intel Pentium processor 
running Windows 2000 with SP3 (Professional and Server), 
WindowsXP with SP1. 

– Solaris SPARC station or Sun Ultra 10 running Solaris 2.7or 2.8. 

• Color monitor with video card set to 256 colors.

Memory (RAM) 256 MB

Browser On Windows 2000 and Windows XP clients:

• Microsoft Internet Explorer 6.0 (version 6.0.2600.0000) or Internet 
Explorer 6.0 with Service Pack 1(version 6.0.2800.1106)

• Java Virtual Machine (JVM) 5.0.0.3802 and above, and Java plug-in 
version 1.3.1. To verify the JVM, select View > Java Console from Internet 
Explorer and Tool s > Server > Java Console from Netscape Navigator.

• Netscape Navigator 4.78, 4.79

On Solaris clients:

• Netscape Navigator 4.76 for Solaris 2.7 and Solaris 2.8

Note For Solaris, use Netscape Navigator downloaded only from the Sun 
site.
1-6
Installation and Setup Guide for Campus Manager on Windows 

78-15050-01

http://www.cisco.com/univercd/cc/td/doc/product/rtrmgmt/cw2000/camp_mgr/sup_dev/cm_3_3.htm


 

Installation and Setup G
78-15050-01
C H A P T E R 2

Installing Campus Manager

This chapter describes how to install, upgrade, uninstall, and reinstall Campus 
Manager (Campus). You must install CiscoWorks Common Services before you 
can install Campus Manager. See Installation and Setup Guide for CiscoWorks 
Common Services on Windows. 

This chapter contains:

• Installation Overview

• Performing a New Installation

• Performing an Upgrade Installation

• Importing Data After Installation

• Uninstalling Campus Manager
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Installation Overview
Table 2-1 is an overview of the Campus Manager installation tasks. It contains 
references to more detailed information about each task.

Table 2-1 Installing Campus Overview

Task Steps References

1. Prepare to 
install Campus.

Verify that server requirements 
are met.

“Server Requirements” section on page 1-3

2. Install 
Campus.

Run the installation program. “Performing a New Installation” section on 
page 2-3

or 

“Performing an Upgrade Installation” section 
on page 2-6

3. Verify and 
troubleshoot 
installation.

a. Verify the correct files and 
directories are installed.

“Understanding Installation Error Messages” 
section on page A-3

b. Analyze installation error 
messages.

“Understanding Installation Error Messages” 
section on page A-3

4. Set up Campus 
Manager

Prepare the system for Campus 
applications and set up the 
applications.

Chapter 3, “Preparing to Use Campus 
Manager”
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Performing a New Installation
This section describes a new Campus Manager installation. If you are upgrading 
from Campus Manager 3.1 or Campus Manager 3.2, see the “Performing an 
Upgrade Installation” section on page 2-6.

Installation Notes
You must install CiscoWorks Common Services 2.2 before installing Campus. See 
Installation and Setup Guide for CiscoWorks Common Services on Windows.

Campus Manager is installed in the directory where you installed CiscoWorks 
Common Services 2.2.

You might see warnings that the installation system is running out of disk space. 
You can chose to free space on the system and click Yes to continue, or click No 
to exit the installation.

The Campus Manager 3.3 installer will automatically update Campus 3.2 and 3.1 
program files and migrate user-entered data related to Campus. The Campus 3.3 
installer will also automatically re-apply some device updates previously released 
on Cisco's download site as Incremental Device Updates (IDU). IDU 1.0 and IDU 
2.0 have been incorporated in Campus 3.3. If you have installed IDU 3.0 or higher 
for Campus 3.2, you will need to re-apply that IDU after the Campus 3.3 
installation is complete.
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Running the Installation Program—New Installation
To install Campus:

Step 1 Insert the Campus CD-ROM into a CD-ROM drive. 

The Installer window opens. Continue to Step 3.

If the Installer window does not open, select Start > Run. The Run dialog box 
opens. 

Step 2 In the Open field, enter:

drive:\autorun.exe

where drive is the CD-ROM drive letter.

Note Campus is installed in the same location as CiscoWorks Common 
Services. The default is C:\Program Files\CSCOpx.

The Installer window opens.

Step 3 Click Install to continue or Cancel to stop.

If you click Install, the Welcome window opens.

Step 4 Click Next to continue.

The Software License Agreement window opens. To Install Campus Manager you 
must accept this agreement.

Step 5 Click Yes to continue.

The ANI Password window opens. 

Step 6 Enter your ANI Password. Otherwise a random password is generated. 

Step 7 Click Next to continue.

The System Requirements Window opens. Verify whether you have the minimum 
system requirements to install Campus Manager.

Step 8 Click Next to continue.

The Summary dialog box opens, displaying the target directory and program 
folder. The target directory is the directory in which you installed CiscoWorks 
Common Services. 
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Note Click the Show Details button in the Summary dialog box to view the ANI 
database password. Store the password in a secure location. You may need it for 
debugging.

Step 9 Click Next to continue.

After installation is complete the following message appears:

To ensure that you retain the latest device support and bug 
fixes, please install the latest Incremental Device Update (IDU) 
for Campus Manager 3.3. You can download the latest IDU from
http://www.cisco.com/cgi-bin/tablebuild.pl/cw2000-campus.

Please refer to the Installation and Setup Guide for details.

Note For more information about IDU, see “FAQs about IDU” section on page A-8.

Step 10 Click OK to continue.

The Setup Complete dialog box opens.

Step 11 Click Finish. 

The CiscoWorks Server starts running.

If errors occurred during installation, check the installation log file in the root 
directory on the drive where the operating system is installed. The default is 
C:\Ciscoworks_setup002.log. Each installation creates a new installation log that 
is saved as a different file. 

For example, the second time you install Campus, the installation log is saved as 
C:\Ciscoworks_setup003.log. The default installation log from the Common 
Services installation is C:\Ciscoworks_setup001.log. For other troubleshooting 
information, see Appendix A, “Troubleshooting the Installation.”
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After the installation completes, do either of the following:

• If you have data from the earlier version of Campus Manager (3.1 or 3.2) to 
import into Campus Manager 3.3, refer to the “Understanding the Data 
Conversion” section on page 2-11.

• If you do not have data to import, continue to Chapter 3, “Preparing to Use 
Campus Manager.”

For more information about the ANI database, see the “Converting Campus Data” 
section on page 2-11.

Performing an Upgrade Installation
You can upgrade to Campus Manager 3.3 from both Campus Manager 3.2 and 
Campus Manager 3.1. For versions earlier than version 3.1, upgrade to Campus 
Manager 3.1 before upgrading to Campus Manager 3.3.

Campus requires CiscoWorks Common Services 2.2 which is the foundation for 
the CiscoWorks Family of Products. When you install CiscoWorks Common 
Services, the previous version of Campus is removed and its database is 
preserved. 

When you install Campus Manager 3.3, certain data from the previous installation 
is preserved. This data includes:

• SNMP community strings

• User Tracking manually entered data fields

• Seed devices

• User preferences

• Path Analysis preferences

Topology views including Layer 2 View, Unconnected Device View and LAN 
Edge View.

You must upgrade to CiscoWorks Common Services 2.2 before installing or 
upgrading to Campus 3.3.
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Note Uninstalling Campus deletes the ANI database.

For more information about the ANI database, see the “Understanding the Data 
Conversion” section on page 2-11.

Installation Notes
You must install CiscoWorks Common Services 2.2 before installing Campus. See 
Installation and Setup Guide for CiscoWorks Common Services on Windows.

Campus Manager is installed in the directory where you installed CiscoWorks 
Common Services 2.2. 

You might see warnings that the target system is running out of disk space. You 
can chose to free space on the system and click Yes to continue, or click No to exit 
the installation.

The Campus Manager 3.3 installer will automatically update Campus 3.2 and 3.1 
program files and migrate user-entered data related to Campus. The Campus 3.3 
installer will also automatically re-apply some device updates previously released 
on Cisco's download site as Incremental Device Updates (IDU). IDU 1.0 and IDU 
2.0 have been incorporated in Campus 3.3. If you have installed IDU 3.0 or higher 
for Campus 3.2, you will need to re-apply that IDU after the Campus 3.3 
installation is complete.

Running the Installation Program—Upgrade or Reinstallation
Use this procedure if you allowed the CiscoWorks Common Services installation 
program to save the previous data and remove the previous software. 

If you installed CiscoWorks Common Services on a clean system, follow the 
procedure for a new installation in the “Performing a New Installation” section on 
page 2-3. 

After installing Campus, you can manually import your existing database to the 
system on which CiscoWorks is installed if it was not automatically imported 
during installation. See the “Importing Data After Installation” section on 
page 2-11.
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To run the installation program for an upgrade:

Step 1 Insert the Campus CD-ROM into a CD-ROM drive. 

The Installer window opens. Continue to Step 4.

Step 2 If the Installer window does not open, select Start > Run. 

The Run dialog box opens. 

Step 3 In the Open field, enter:

drive:\autorun.exe

where drive is the CD-ROM drive letter.

Note Campus is installed in the same location as CiscoWorks Common 
Services. The default is C:\Program Files\CSCOpx.

The Installer window opens. Continue to step 4.

Step 4 Click Install to continue or Cancel to stop.

If you click Install, the Welcome window opens.

Step 5 Click Next to continue.

The Software License Agreement window opens. To Install Campus Manager you 
must accept this agreement.

Step 6 Click Yes to continue.

The ANI Password window opens. 

Step 7 Enter your ANI Password. Otherwise a random password is generated. 

Step 8 Click Next to continue.

The System Requirements Window opens. Verify whether you have the minimum 
system requirements to install Campus Manager.

Step 9 Click Next to continue.

The Summary dialog box opens, displaying the target directory and program 
folder. The target directory is the directory in which you installed CiscoWorks 
Common Services.
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Note The Show Details button appears in the Summary dialog box only if you entered 
a new password. Click the Show Details button to view the ANI database 
password. Store the password in a secure location. You may need it for debugging.

Step 10 Click Next to continue.

The installation program converts your database but does not remove the original 
database. The original database is preserved and remains until you manually 
remove it.

If there is not enough disk space in the location to convert and import the archived 
database, an information message appears. If you have data you want to save and 
upgrade but not enough disk space, do one of the following:

• Free up enough disk space to be able to save and upgrade data, then continue 
with the installation process.

• Install Common Services, and Campus on a different machine, then remotely 
import the data. Refer to the “Importing Data After Installation” section on 
page 2-11.

After installation is complete the following message appears:

To ensure that you retain the latest device support and bug 
fixes, please install the latest Incremental Device Update (IDU) 
for Campus Manager 3.3. You can download the latest IDU from
http://www.cisco.com/cgi-bin/tablebuild.pl/cw2000-campus.

Please refer to the Installation and Setup Guide for details.

Note For more information about IDU, see “FAQs about IDU” section on page A-8.

Step 11 Click OK to continue.

The Setup Complete dialog box opens.

Step 12 Click Finish. 

The CiscoWorks Server starts running.
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If errors occurred during installation, check the installation log file in the root 
directory on the drive where the operating system is installed. The default is 
C:\Ciscoworks_setup002.log. Each installation creates a new installation log that 
is saved as a different file. 

For example, the second time you install Campus, the installation log is saved as 
C:\Ciscoworks_setup003.log. The default installation log from the Common 
Services installation is C:\Ciscoworks_setup001.log. For other troubleshooting 
information, see Appendix A, “Troubleshooting the Installation.”

After the installation completes, choose either of the following:

• If you installed Campus on a different system and have data to import, you 
can import the database remotely. See the “Importing Data After Installation” 
section on page 2-11 section for more information.

• If your data is already converted or you do not want to import the old data, 
continue to Chapter 3, “Preparing to Use Campus Manager.”

After Campus is installed, Topology Services allows you to either convert the 
saved views into the new Campus Manager 3.3 format or directly use the default 
views generated by Campus Manager 3.3. See “Upgrading Saved Views From 
Topology Services” section for more information.

Upgrading Saved Views From Topology Services
Use the following procedure to upgrade saved topology views to the new Campus 
Manager 3.3 format. 

If you do not want to upgrade to the new format but want to use the default views 
generated by previous versions of Campus Manager (3.1 and 3.2), skip the 
following procedure and select Layer 2 View, LAN Edge View, or Unconnected 
Devices View from the side panel in Topology Services.

Step 1 Start Topology Services from the desktop.

Step 2 Select File > Upgrade View Layouts.

Step 3 Select the view you want to upgrade.

Step 4 Click Upgrade to upgrade the selected view.

Topology Services upgrades the selected view in the Campus Manager 3.3 format. 
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Step 5 To display this view, select the corresponding view from the side panel in 
Topology Services.

Note The upgraded view might not be formatted exactly the same as the 
previous version of the view. This is because of the new features in 
Campus Manager 3.3.

Importing Data After Installation
This section describes how to manually import data from previous versions of 
Campus. You might need to import data manually if you performed a new 
installation of Campus but have data from previous versions of the software on a 
different system.

Understanding the Data Conversion
Data can be converted from both Campus Manager 3.1 and Campus Manager 3.2 
formats to Campus Manager 3.3 format. 

Converting Campus Data

Campus Manger accesses the ANI database for critical network information. 
During an upgrade from Campus Manager 3.1 or 3.2 the database is saved. Data 
from the saved database can be converted to Campus Manager 3.3 format for 
immediate use.

The CiscoWorks Common Services installation, which is required for the Campus 
Manager installation, automatically saves your old database. When you install 
Campus Manager, the saved database is imported into the new file, ani.db. After 
you import your database into Campus Manager 3.3, the old ANI database, called 
ani.db, remains in the directory you indicated during the Common Services install 
until you remove it. 

For more information about the ANI database, see the ANI online help or User 
Guide for Campus Manager.
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Converting Campus 3.1 and Campus 3.2 Data

The community strings are upgraded from the old anisnmp.conf file to the updated 
anisnmp.conf file. Some critical properties from the old ANIServer.properties file 
are updated in the new ANIServer.properties file.

The User Tracking data is extracted from the old ani.db file and saved as 
rigel_ut.txt. This data is found and processed during the first User Tracking 
discovery.

Topology Services saves topology views from the earlier versions of Campus 
Manager (3.1 or 3.2). The following views are saved:

• Layer 2 View

• Unconnected Device View

• LAN Edge View

Importing Data Manually from Campus Manager 3.1 or 3.2
Follow this procedure to remotely import saved data from Campus Manager 3.1 
or 3.2.

Step 1 Stop the daemon manager on the local machine on which the previous version of 
Campus Manager is installed. 

For more information on stopping the daemon manager, see Installation and Setup 
Guide for CiscoWorks Common Services on Windows.

Step 2 Insert the CiscoWorks Common Services 2.2 CD-ROM into the CD-ROM drive 
on the local machine. 

The Installer window opens. 

Step 3 Click Cancel.

Step 4 Select Start > Run. 

The Run dialog box opens. 
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Step 5 To save CiscoWorks data, run:

NMSROOT/bin/perl drive:\ export_cdone.pl

where drive is the CD-ROM drive letter. A prompt appears asking you to enter the 
location where you want to export CiscoWorks Common Services data.The 
default location is C:\PROGRA~1\CSCOpx\rigel 

Step 6 Insert the Campus CD-ROM into the CD-ROM drive.

Step 7 To save Campus data, run:

NMSROOT/bin/perl drive:\ export_cm.pl

where drive is the CD-ROM drive letter. A prompt appears asking you to enter the 
location where you want to export Campus data.The default location is 
C:\PROGRA~1\CSCOpx\rigel.

Note You must export Campus data to the location where CiscoWorks Common 
Services data has been exported.

Step 8 Copy all subdirectories except the scripts directory from the location in the local 
machine to which you have exported the data to NMSROOT\rigel\ on the remote 
machine.

Step 9 Start the daemon manager on the local machine. 

For more information, refer to Installation and Setup Guide for CiscoWorks 
Common Services on Windows.

Step 10 Stop the daemon manager on the remote machine. 

For more information on stopping the daemon manager, refer to Installation and 
Setup Guide for CiscoWorks Common Services on Windows.

Step 11 To copy CiscoWorks data to corresponding Common Services 2.2 directories on 
the remote machine, enter:

cd /d NMSROOT\rigel\scripts
NMSROOT\bin\perl import_cdone.pl.

A prompt appears:

Importing will cause all the export data files to be overwritten.
Are you sure you want to import CiscoWorks data (y/n)? [n]

Step 12 Enter y to import and n to cancel.
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Step 13 To copy Campus data to corresponding Campus Manager 3.3 directories on the 
remote machine, enter:

cd /d NMSROOT\rigel\scripts
NMSROOT\bin\perl import_cm.pl

A prompt appears:
Importing will cause all the files to be overwritten. Are you sure you 

want to import Campus data (y/n)? [n]

Step 14 Enter y to import and n to cancel.

Step 15 Start the daemon manager on the remote machine. See Installation and Setup 
Guide for CiscoWorks Common Services on Windows for more information.

After the data is imported, Topology Services allows you to either convert the 
saved views into the new Campus Manager 3.3 format or directly use the default 
views generated by Campus Manager 3.3. See the “Upgrading Saved Views From 
Topology Services” section for more information.
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Uninstalling Campus Manager
The uninstallation program removes Campus files and settings. Uninstallation 
allows you to remove only Campus or remove CiscoWorks Common Services as 
well.

Caution You must use the Campus Manager uninstallation program to remove the product. 
If you try to remove Campus or its components manually, you could damage your 
system.

Caution Uninstalling Campus Manager deletes the ANI database. To upgrade and convert 
the database, see the “Performing an Upgrade Installation” section on page 2-6.

To remove Campus or other major components:

Step 1 Select Start > Programs> CiscoWorks > Uninstall CiscoWorks. 

The Uninstallation dialog box appears, displaying all of the installed components.

Step 2 Deselect the components you do not want to remove or click Uninstall All.

Step 3 Click Next to begin uninstalling Campus.

A dialog box opens, listing the components selected for uninstallation.

Step 4 Click Next after verifying the components to be uninstalled.

Messages about the uninstall process appear and the uninstallation finishes.

To reinstall Campus, follow the instructions in the “Performing an Upgrade 
Installation” section on page 2-6
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Preparing to Use Campus Manager

This chapter describes the various administrator and application setup tasks that 
you must perform after installing Campus Manager (Campus). 

This chapter contains:

• Overview of Campus Setup Tasks

• Accessing the CiscoWorks Server

• Performing Administrator Tasks

• Setting Up Campus Manager Applications

• Logging Out as Administrator
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Overview of Campus Setup Tasks
Table 3-1 provides an overview of Campus Manager setup tasks, with references 
to more detailed information about each task. 

Table 3-1 Preparing to Use Campus Manager Task Overview

Task Steps References

1. Access the 
server.

Access the CiscoWorks Server. “Accessing the CiscoWorks Server” 
section on page 3-3

2. Perform 
administrator 
setup tasks.

a. Log in to the server as administrator. “Logging In as Administrator” section 
on page 3-4

b. Back up the ANI database. “Backing Up the ANI Database” 
section on page 3-5

3. Set up 
applications.

Start and configure applications. “Setting Up Campus Manager 
Applications” section on page 3-5

4. Log out. Log out of the server. “Logging Out as Administrator” 
section on page 3-12
3-2
Installation and Setup Guide for Campus Manager on Windows 

78-15050-01



 

Chapter 3      Preparing to Use Campus Manager
Accessing the CiscoWorks Server
Accessing the CiscoWorks Server

Note You must set up the client system before using Campus. See Installation and 
Setup Guide for CiscoWorks Common Services on Windows for configuring 
browser and client systems.

To access Campus Manager, enter the URL of the CiscoWorks Server in your web 
browser:

http://server_name:1741
https://server_name:1742 (for SSL mode)

where server_name is the name of the CiscoWorks Server and 1741and 1742 are 
the ports on which it was installed. If you were prompted to supply a different port 
number for the CiscoWorks Server during the installation, use that port number 
in the URL.

If you cannot access the CiscoWorks Server or the desktop is not displayed 
correctly, see Appendix A, “Troubleshooting the Installation” In addition, refer to 
the troubleshooting chapter in User Guide for Campus Manager. 

After you access the CiscoWorks Server, continue to the “Performing 
Administrator Tasks” section on page 3-4.
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Performing Administrator Tasks
To perform administrator tasks, you must log in as administrator and set up the 
server for other users.

Logging In as Administrator
To log in as administrator:

Step 1 Enter the system administrator username and password in the Login Manager 
dialog box.

Step 2 Click Connect.

The Login Manager dialog box is replaced by the navigation tree.

To log out of the CiscoWorks Server, see the “Logging Out as Administrator” 
section on page 3-12 for information.

After you log in as the administrator, continue to the “Backing Up the ANI 
Database” section on page 3-5
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Backing Up the ANI Database
You should back up the ANI database immediately after a new or upgrade 
installation. This creates a backup compatible with the previous Campus Manager 
versions (3.1 or 3.2) in case you must restore your database. This also prevents 
you from overwriting your database by restoring a backup from the previous 
version. See the ANI Server online help or User Guide for Campus Manager for 
more information.

After you perform the necessary administrator tasks, continue to the “Setting Up 
Campus Manager Applications” section on page 3-5.

Setting Up Campus Manager Applications
This section describes the tasks that you must perform to set up the Campus 
Manager applications. See the online help for individual applications for 
troubleshooting information.

This section contains:

• Setting Up Your Network

• Configuring the ANI Server

• Setting Up Topology Services

• Setting Up User Tracking

• Setting Up Path Analysis

• Setting Up VLAN Port Assignment

• Setting Up Discrepancy Reports

• Logging Out as Administrator

Note Many tasks require the administrator login.
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Setting Up Your Network
To ensure that the ANI Server successfully discovers the devices in your network, 
you must set up your network correctly. Table 3-2 shows the required tasks for 
each application, marked by a check mark ( ). 

See the ANI Server online help, User Guide for Campus Manager and User Guide 
for CiscoWorks Server for more information.

After you set up your network, continue to the ““Configuring the ANI Server” 
section on page 3-7.

Table 3-2 Network Setup Tasks

Topology 
Services

User 
Tracking

Path 
Analysis

VLAN Port 
Assignment

Discrepancy 
Reports  Requirement

Connect to seed device.

Enable Simple Network Management 
Protocol (SNMP).

Enable Cisco Discovery Protocol 
(CDP).

Enable Call Detail Record (CDR).

Set a unique sysName variable on 
devices.

Enable Integrated Local Management 
Interface (ILMI) on ATM devices.

Configure DNS.

Configure VLAN Trunk Protocol 
(VTP).

Configure VLAN trunks on Fast 
Ethernet and Gigabit Ethernet.

Create the default configuration server 
for ATM LAN Emulation (LANE). 

Enable source routing.
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Configuring the ANI Server
Before starting a Campus Manager application, the ANI Server must be running 
and properly set up. You must verify that the correct community strings and a seed 
device are specified. In SNMP settings, there is a check box option to encrypt and 
store the community strings in the server. 

For security reasons we recommend that you enable this option. If you do not 
enable this option the community strings will be stored as plain text. You can also 
check to see that the ANI Server is running. See the ANI Server online help and 
User Guide for Campus Manager for assistance in performing these tasks.

After you configure the ANI Server, see the “Setting Up Topology Services” 
section on page 3-7.

Setting Up Topology Services
To set up Topology Services:

Step 1 Add a seed device to the ANI Server. 

For more information, see the Topology Services or the ANI online help.

Step 2 Make sure the ANI Server is running. 

See the ANI Server online help for more information.

Step 3 Select Campus Manager> Topology Services to start the application.

Configuring Network Discrepancies

You can configure the network discrepancies that you would like reported by 
selecting and deselecting the listed discrepancies. Select Campus 
Manager>Administration> Network Discrepancies. See User Guide for 
Campus Manager for more information.
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Verifying Topology Services 

To verify that Topology Services is working properly:

Step 1 Verify that all devices and interfaces are discovered. 

Properly discovered devices and interfaces appear in green in the Topology 
Services window.

Step 2 Verify that devices displayed in red are reachable and have correct community 
strings.

Step 3 Verify that all VLANs and ELANs are discovered and that their port assignments 
are correct.

For more information, see the Topology Services online help.

Setting Up User Tracking
To set up User Tracking:

Step 1 Start User Tracking. 

Step 2 Confirm that the ping sweeps option is enabled. 

If you enable User and Host Acquisition, perform the tasks outlined in the 
“Supporting User Name Collection” section on page 3-8.

For more information, see the User Tracking online help.

Supporting User Name Collection

To have the ANI Server automatically retrieve user names for User Tracking, you 
must enable user and host acquisition and install appropriate scripts. See the ANI 
Server online help for more information.
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Verifying User Tracking 

To verify that User Tracking is working properly, discover with a ping sweep to 
verify that all end-user stations are discovered.

Setting Up Path Analysis
To set up Path Analysis:

Step 1 Install and configure a DNS server on your network. 

A DNS server is required for Campus Manager. For devices with multiple IP 
addresses, there should be a single DNS entry that includes all IP addresses.

Step 2 Specify correct read community strings on all devices. 

Step 3 Specify correct write community strings for multi-layer switching shortcut path 
determination on Catalyst 5000 devices.

Step 4 Edit the VLAN/ELAN Mapping Table, which provides mapping of VLANs and 
ELANs to subnets. 

These mappings are auto-discovered based on information discovered by 
Topology Services and User Tracking. 

In some cases, the information might be incomplete. In these cases, you can edit 
a VLAN/ELAN mapping table to supplement the Topology Services and User 
Tracking information. If subnet mappings are not correct, Layer 2 traces on those 
subnets might fail.

Step 5 Enable Cisco Discovery Protocol (CDP) on all Cisco devices. 

If CDP is not enabled, these devices will not appear on Layer 2 path traces.

Step 6 Enable source routing on your network. 

This is required if you plan to run path traces outside of the domain known to 
Topology Services.

For more information, see the Path Analysis online help.
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Setting Up Campus Manager Applications
Verifying Path Analysis 

To verify that Path Analysis is working properly:

Step 1 Run Action >Discover All.

Step 2 Start Topology Services and make sure that all devices, interfaces, and links are 
discovered properly. 

Properly discovered devices appear in green in the Topology Services window. 

Step 3 Verify that all VLANs and ELANs are discovered with correct port assignments.

Step 4 Start User Tracking and run Discovery with a ping sweep to verify that all 
end-user stations are discovered.

Step 5 Run nslookup on several known devices in the DOS shell. 

Step 6 Verify that DNS lookup works and takes one second or less.

Step 7 Verify the Subnet Mapping table entries. 

Each VLAN and ELAN entry should have any corresponding subnets listed. Any 
subnets that do not correspond to a VLAN or ELAN should be in a Subnet row.

Step 8 Run a few traces between endpoints known to User Tracking or Topology Services 
and verify that the trace completed successfully.

For troubleshooting information, see the Path Analysis online help.

Setting Up VLAN Port Assignment
To set up VLAN Port Assignment, Start VLAN Port Assignment. 

For more information, see the VLAN Port Assignment online help.

Displaying Topology Views and Attribute Summaries

To highlight devices, VLANs in a VTP domain, or a VTP domain map, or to 
display attribute summaries for devices, Topology Services must be running. See 
the VLAN Port Assignment online help for more information.
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Setting Up Campus Manager Applications
Verifying VLAN Port Assignment

To verify that VLAN Port Assignment is working properly:

Step 1 Check the status bar to verify that the ANI Server is running properly.

Step 2 Perform a port summary for a VTP Domain. 

The table should be populated that domain’s port information.

Step 3 Select a port, preferably unconnected, and move it to a different VLAN. 

The port information should be updated.

See the VLAN Port Assignment online help for more information.

Setting Up Discrepancy Reports
To set up Discrepancy Reports:

Step 1 Select the Discrepancy Reports folder from the desktop

Step 2 Start Physical Discrepancy Reports or Logical Discrepancy reports.

For more information, see the Discrepancy Reports online help.

Verifying Discrepancy Reports

To verify that Discrepancy Reports is working properly, check the status bar to 
verify that the ANI Server is running properly.
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Logging Out as Administrator
To end your administrator tasks, you must log out of Campus Manager. 

Step 1 Close all secondary browser windows. You should have only one browser window 
opened displaying the Campus Manager interface.

Step 2 Click Logout. 

The Login Manager dialog box replaces the navigation tree.
3-12
Installation and Setup Guide for Campus Manager on Windows 

78-15050-01



 

Installation and Setup G
78-15050-01

A
 P P E N D I X A

Troubleshooting the Installation

This appendix provides troubleshooting information for Campus Manager 
(Campus) installation and setup.

This appendix contains:

• Logging In After Upgrading

• Understanding Installation Error Messages

• Accessing the CiscoWorks Server

• FAQs about IDU
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Logging In After Upgrading
Logging In After Upgrading
If the Login Manager dialog box on the CiscoWorks desktop does not appear 
correctly when you try to log in for the first time after upgrading, clear your 
browser cache as follows, then reenter the server URL in your browser.

For Microsoft Internet Explorer:

Step 1 Select Tools> Internet Options. 

The Internet Options dialog box appears.

Step 2 Select the General tab.

Step 3 Click Delete Files, then click OK in the Delete Files dialog box.

For Netscape Navigator:

Step 1 Select Edit>Preferences. 

The Preferences dialog box appears.

Step 2 Select Advanced>Cache.

Step 3 Click Clear Memory Cache, then click OK in the Memory Cache dialog box.

Step 4 Click Clear Disk Cache, then click OK in the Disk Cache dialog box.
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Understanding Installation Error Messages
After verifying that the correct files are installed, check the 
C:\Ciscoworks_setup002.log file (or the log file with the highest number, for 
example Ciscoworks_setup003.log) for installation errors. 

The following types of installation error messages might appear:

• Information messages, which give important details

• Warning messages, which inform you that something might be wrong with a 
particular process, but the process will complete

• Error messages, which inform you that a particular process could not 
complete

Table A-1 shows error messages that might occur during installation and 
describes the reasons for the errors.

 
Table A-1 Installation Error Messages

Message Reason for Message User Action

CiscoWorks installation cannot 
proceed because you are not 
logged in as an administrator.

You are not logged in to 
Windows with administrator 
privileges.

Log in with local administrator 
privileges and try installing 
again.

Decompression failed on file. The 
error was for error code per 
CompressGet.

If Campus was downloaded, a 
transmission error occurred, or 
installation media is damaged.

Retry the download. If you 
still have errors, contact your 
technical support 
representative.

General file transmission error. 
Please check your target location 
and try again. Error number: error 
code.

If Campus was downloaded, a 
transmission error might have 
occurred. 

Retry the download. If you 
still have errors, contact your 
technical support 
representative.

Unable to write infoFile or Unable 
to create infoFile.

A file write operation failed. Run the file system checking 
utility, then repeat the 
installation.

Cannot stop service servicename. The installation (or reinstallation) 
tried to stop service servicename 
unsuccessfully.

Select Control Panel > 
Services and try to stop service 
servicename manually, then 
proceed with installing or 
uninstalling.
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UseDLL failed for dll. dll is supposed to be available at 
any time for any process, but 
Windows failed to load it.

Check permissions on 
Windows System32. If the dll 
is secure.dll or r_inst.dll, 
check product installation 
medium for errors.

or

Reinstall Windows.

OpenFile failed: pathname A file open operation failed. Run the files system checking 
utility, then repeat installation.

ProtectFile failed: file: error. 
WWW admin security may be 
incomplete.

Setting file permissions failed 
because you may not be allowed 
to change them.

Log in as administrator.

Launch of isql script failed. The existing database file is 
broken, or the previous version of 
Campus is destroyed. (This 
message might be issued during 
reinstallation.) 

Contact your support 
representative.

You have less than 1M free space 
on drive name. Free up some 
space and try again.

Insufficient drive space for 
temporary installation files.

Make more drive space 
available, then rerun the 
installation program.

This program requires to run on 
Windows.

You attempted to install on a 
system that does not have 
Windows with Service Pack 3 
installed.

Install Campus on a Windows 
Professional system that is not 
configured as a PDC or BDC.

Unable to determine the type of 
operating system. Campus can be 
installed only on Windows with 
SP3.

Installation program could not 
determine which operating 
system is running.

Install on a Windows 
Professional system that is not 
configured as a PDC or BDC.

Table A-1 Installation Error Messages (continued)

Message Reason for Message User Action
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Physical memory is <...>M 
Paging File Size is: File Size is: 
<...>M(initial), 
<...>M(maximum). It is 
recommended that initial paging 
file size is bigger than physical 
memory and maximum paging file 
size is at least twice as big as 
physical memory.

(Maximum paging file size might 
not appear.)

The paging file size is smaller 
than recommended.

Finish installation, then 
increase paging file size.

There is not enough space 
available on the disk drive: This 
drive has <...> bytes in a cluster. 
Total required <...> clusters (<...> 
bytes), only <...> clusters (<...> 
bytes) available. Please free up 
some space or change the target 
location to a different disk.

(Second sentence might be as 
follows instead of as above: 
“Please free up some space and 
rerun installation.”)

Insufficient disk space available 
on drive to install the product.

Create additional free space on 
the drive or install on a 
different drive.

Cannot determine the local 
Administrators group.

Installation program cannot find 
one of the built-in Windows user 
groups. This prevents setup of 
Campus security.

Check the Windows operating 
system. Reinstall Windows if 
necessary, then rerun 
installation.

Cannot determine the local 
Everyone group.

The installation program cannot 
find one of the built-in Windows 
user groups. This prevents the 
setup of Campus security.

Check the Windows operating 
system. Reinstall Windows if 
necessary, then rerun 
installation.

Table A-1 Installation Error Messages (continued)

Message Reason for Message User Action
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Failed to set file permissions. The installation program is 
unable to set file permissions. The 
most likely causes are:

• The account you used to log 
in to the system has 
insufficient permissions.

• The drive on which you are 
installing the product has a 
FAT file system.

Fix problem, then rerun 
installation.

<...> is already running! Wait for 
it to finish and press the OK 
button below.

One of the installation subtasks is 
still running.

Wait for subtask to finish 
running, then click OK to 
proceed.

Unable to create/open log file. The installation program was 
unable to create or open 
installation log file (in the root 
directory of the drive on which 
you are installing) named 
Ciscoworks_setupxxx.log, where 
xxx is a sequential number 
starting from 001).

Determine why file could not 
be created or opened, fix 
problem, then rerun 
installation. Common causes 
of this problem are lack of disk 
space or write protection on 
the file.

Error creating user bin <... more 
info here> Refer To the 
troubleshooting section in user 
manual

The installation program could 
not create the user account bin.

Fix problem, then rerun the 
installation.

Can not find script to upgrade 
database

There was a problem with the 
database upgrade.

Contact your technical support 
representative.

Database upgrade failed There was a problem with the 
database upgrade.

Contact your technical support 
representative.

Database upgrade result unknown There was a problem with the 
database upgrade.

Contact your technical support 
representative.

Table A-1 Installation Error Messages (continued)

Message Reason for Message User Action
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Accessing the CiscoWorks Server
The CiscoWorks server uses port 1741 by default (1742 if SSL is enabled). If you 
receive an error message informing you that an alternative port is used instead, 
verify that you entered the correct URL for the server:

http://server_name:port

where server_name is the name of the machine on which CiscoWorks was 
installed and port is the port number 1741 or the number supplied during 
installation.

If you still cannot access the server, enter the following command at a DOS 
prompt to make sure your server is running:

ping server_name

If you get a message informing you that the server is “alive” and get a proxy error 
when you try to connect to the server, make sure the proxy is set up correctly. If 
your server is configured to use a proxy server outside the firewall, you will get 
proxy errors if you configured the proxy to ignore requests to a certain machine, 
set of machines, or domain. 

You specify a proxy server in Netscape Navigator under 
Edit>Preferences> Advanced>Proxies and in Internet Explorer under 
Tools> Internet Options >Connections> LAN Settings. 

Your proxy is set up incorrectly if: 

• You receive an error message informing you that you are using a proxy 
outside the firewall.

• The proxy server recognizes www-int as an internal server, so it does not 
proxy requests to that server.

• You set up a new internal server, www-nms, but when you make a request to 
the proxy server, it does not recognize www-nms as an internal server and 
proxies the request.

• The proxy server outside the firewall tries to request data from a server inside 
the firewall, and the request is blocked.

• You get a “Connection Refused” error from the proxy server.
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FAQs about IDU
Q. What is an IDU?

A. IDU (Incremental Device Update) for a CiscoWorks application is a 
downloadable package containing a collection of updated files to provide you 
with support for new devices. In addition, the package also contains fixes to 
certain known problems, as well as fixes to newly discovered problems. IDUs 
are available for download for various versions of CiscoWorks applications.

Q. Why should I install the latest IDU?

A. If you had installed IDU 2.0 on Campus3.2, and then upgraded to Campus 
3.3, you will not lose any device support. This is because IDU 2.0 has been 
merged into Campus 3.3. But, if you had installed a version of IDU later than 
2.0 on Campus, and then upgraded to Campus 3.3, you will lose support for 
new devices, and fixes to known problems.

Q. Where can I download an IDU?

A. To retain support for new devices, we recommend that you download and 
install the latest IDU for Campus 3.3 from

http://www.cisco.com/cgi-bin/tablebuild.pl/cw2000-campus

Q. How do I know which version of IDU I have installed?

A. To check the version of IDU installed on your system, from the CiscoWorks 
desktop, select Server Configuration > About the Server > Applications 
and Versions.

The Patches Installed table displays the installed version of the applications 
in the following format:

If Patches Installed table displays IDU version installed is...

CM3_2_IDU-1.0 IDU 1.0 on Campus 3.2

CM3_2_IDU-2.0 IDU 2.0 on Campus 3.2

CM3_2_IDU-3.0 IDU 3.0 on Campus 3.2
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Q. I have upgraded to Campus 3.3. But, I have lost support for some devices. 
Why?

A. If you had installed IDU 2.0 on Campus 3.2, and then upgraded to Campus 
3.3, you will not lose any device support. This is because IDU 2.0 has been 
rolled into Campus 3.3 . But, if you had installed a version of IDU later than 
2.0 on Campus 3.2, and then upgraded to Campus 3.3, you will lose support 
for new devices.

To retain support for the new devices, we recommend that you download and 
install the latest IDU for Campus 3.3 from

http://www.cisco.com/cgi-bin/tablebuild.pl/cw2000-campus
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